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Using this 
template  

The standard headings and tables in this template should be modified to meet the 
requirements of each Initial Assessment.  The sites may have diverse issues and 
constraints and problems and the standard template is therefore just a guide on 
typical requirements but flexibility is allowed to amend/ add headings as required 

 
 Hidden 
guidance  

The template contains various pieces of guidance covering content, use of tables 
etc.  The guidance is shown in blue text and can be turned ‘on’ to assist in the 
writing stages or ‘hidden’ for viewing or when printing the document.  You can 
switch between ‘hidden’ and ‘on’ and back to ‘hidden’ at any time. 

To show/hide the guidance click on the ¶ icon on the MS Word toolbar.  

If the hidden text does not disappear off the screen when the ¶ icon is clicked, go 
to:  Tools>Options>View Tab and uncheck the ‘Hidden text’ box.   

It is advisable to work with the hidden text turned on, as this helps to format new 
text and to avoid deleting the hidden text itself. 

 
Auto-
updating of 
contents 
page 

The contents page will update to reflect changed information in the main text and 
tables.  To update right click on the relevant area of the contents page, to highlight 
it, and select ‘Update Field” to access the update option. 

To enable these updating features to be created, the document contains specific 
text types and “fields”.  These are Headings 1, 2, 3 & 4; fields in the table labels 
and in the appendix labels.  When editing the document, take care to maintain 
these aspects. 

 
Inserting new 
headings  

To insert new headings in the main text go to: Format>Styles and Formatting to 
open the styles box. Insert the new headings, highlight it and click on the 
appropriate Heading level in the ‘Pick formatting to apply’ box.  Paragraph text 
can be inserted and formatted in a similar way. 

 
Inserting new 
tables  

Table labels should be added by Insert>Reference>Caption and selecting ‘Table’ 
from the drop down ‘Label’ box.  This will insert the Table title with the correct 
number and the caption can be typed in after the label.  Tables can then be cross 
referenced from the text by Insert>Reference>Cross Reference and selecting the 
appropriate reference type and caption from the drop down box and list. 

 
Numbering 
paragraphs  

All paragraphs should be numbered sequentially as sub-sets of the section 
number. Prompts for paragraph numbering are provided as ‘Start writing here’ 
after which pressing <return> will automatically provide the next paragraph 
number.  

 

Bradford Initial assessment report  
Glenaire Court - Baildon 
November 2016 
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1.1  Introduction and background 

1.1.1 Background 

In May 2016 CH2M were commissioned by the Environment Agency to undertake Yorkshire 
Area Initial Assessments report for Lower Holme in Baildon providing guidance on measures to 
reduce flood risk and potential funding availability. A site visit for this Initial Assessment was 
undertaken on 18th of July 2016. This report is based on information from the site visit and 
previous studies and reports that are relevant to this Initial Assessment. 

1.1.2 Description of Location 

Baildon is a town located 5km to the north-east of Bradford. It is part of the Metropolitan District 
of the City of Bradford. The Leeds and Liverpool Canal and the River Aire run through the town. 
The area is within the River Aire Middle Catchment Flood Warning Area.  

The Baildon/Shipley area is comprised of five individual benefit areas; Aire Close, Baildon 
Bridge, Glenaire Court, Lower Holme and Masons Mill.    

 

Glenaire Court cell is located on the left bank of the River Aire, stretching downstream of 
Baildon Bridge to Baildon Bridge Retail Park. A location plan of the site is shown in Appendix H.   

According to the Index of Multiple Deprivation (IMD), the study area lies within the 30% most 
deprived areas in the country. 

1.1.3 Description of Watercourses and Geology 

The River Aire is a major watercourse in Yorkshire flowing from Malhamin the Yorkshire Dales, 
through the urban areas of Bradford and Leeds, before joining the Rover Ouse at Airmyn.  The 
Aire is approximately 114km in length from its source to its confluence. 

The River Aire around Shipley and Baildon is heavily urbanised and the floodplain is 
constrained by development. There is also a large number of structures such as bridges and 
weirs in this area.  

The underlying bedrock of the Area of Baildon is Millstone Grit, overlain by lover coal measures. 
Ground condition could be described as slowly permeable seasonally wet acid loamy and 
clayey soils. 

 
 
1.1.4 History of Flooding 
The properties in Baildon have been flooded several times in the past. During the December 
2015 event flooding occurred most likely due to high river levels in the River Aire overtopping 
the river banks and flood defences. 
 
Six historic flood events in Shipley have been identified from previous reports and studies – in 
1909, 1967, 1980, 2000 and 2008. Shipley is on the south side of the river Aire whilst Baildon is 
on the north, opposite bank, and it is therefore assumed that both locations were affected at the 
same time. 
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1.1.5 Summary of modelling analysis 

In 2008 hydraulic and hydrological modelling of the Upper River Aire was completed by JBA to 
support the development of the Flood Risk Management Strategy. For this study the River Aire 
was modelled from High Hill Weir upstream of Gargrave to Fleet Weir downstream of Leeds. 
The Upper River Aire model is a 1D hydrodynamic ISIS model containing 1922 nodes. 

This 2008 study aimed to define flood risk within this area and identify potential flood risk 
management options. This informed the Flood Risk Management Strategy for the Upper Aire 
which proposed flood risk management options for the short, medium and long-term. These 
recommendations included progressing a flood management scheme for defences at Baildon. 

Following the December 2015 flood event the  detailed modelling is being undertaken by the EA 
National Flood Modelling Team and it is still subject to confirmation. For the purpose of the 
Initial Assessment report, initial review of modelled options shown below, have been provided: 

• Three Weir Study – Re-run the Aire Model using the estimate December 2015 flows 
to investigate the removal of three weirs around Shipley and Baildon. 

• Baildon Bridge Blockage Analysis – Re-run the Aire Model using the estimated 
December 2015 flow to complete blockage analysis on Baildon Bridge. 

• Wall Scenario Downstream of Baildon Weir – Following the December 2015 event a 
riparian owner has raised the height of a flood wall on the right bank.  Various 
modelling runs have been carried out to determine the impact of the raise wall on 
flood risk to the left bank. 

1.1.6 Drivers, Constraints and Opportunities 

The Aire River falls under the Aire Catchment Flood Management Plan and is covered by sub-
area 3 – Worth and Aire. The CFMP can be found here: 
https://www.gov.uk/government/uploads/system/uploads/attachment_data/file/289346/River_Air
e_Catchment_Flood_Management_Plan.pdf. The designated policy for the area at risk is ‘Policy 
Option 5: Areas of moderate to high flood risk where we can generally take further action to 
reduce flood risk. 

The following drivers, constraints and opportunities have been identified within the study area.  

Political Drivers  Summary Description 

Catchment Flood 

Management Plan 

River Aire Catchment Flood Management Plan 

Catchment Flood 

Management Policy 

5 - areas of moderate to high flood risk where we can 

generally take further action to reduce flood risk 

Economic Drivers   Summary Description 

Funding Time Constraints Must be obtained within 6 year programme of capital 

investment 

Social Constraints   Summary Description 

Existing Public Space Residential and commercial space in the town 

Environmental Constraints  Summary Description 

World Heritage Site A desk study of MAGIC reveals the eastern boundary of the 

Saltaire World Heritage Site approximately 1km to the west 

of the benefits area. Works to the site have the potential to 

impact the World Heritage Site. A full impact assessment 

should be conducted once an option has been selected. 

Site of Special Scientific 

Interest (SSSI) 

The benefits area lies approximately 2km east of the Trench 

Meadows SSSI. This is a biologically important site. The 

benefits area thus lies within a SSSI impact risk zone. 
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Ancient Woodland There is an Ancient Replanted Woodland - Fairbank Wood 

0.3 kilometres to the north west; Ancient Woodlands - 

Midgeley Wood 1 kilometre to the north west; Old Spring 

Wood 1.2 kilometres to the south west and Thackley West 

Wood 1.3 kilometre to the north east. 

Contaminated Land  There are no records of historical landfill sites within the 

benefits area. 

Tree Preservation Orders  There are no tree preservation orders within the benefits 

area, however, there are several protected trees adjacent to 

the benefits area along the A6038. 

Ground Conditions Slowly permeable seasonally wet acid loamy and clayey soils 

Scheduled Monument Scheduled monument 0.7 kilometres to the north; another 

one 0.7 kilometres to the south 

Listed Buildings/Structures There are no listed buildings on or in the vicinity of the 

benefit area. 

Historical Park & Gardens Roberts Park 1.1 kilometres to the north west. 

WFD Body River Aire (River Worth to Gill Beck) 

WFD Status Moderate 

Refer to Appendix B for the full list of constraints that were considered. 

 

1.2 Problem and objectives 

1.2.1 Problem 

Based on the evidence provide and local anecdotal knowledge, it is very likely that the flooding 
during the December 2015 event was predominantly from fluvial sources.   There are 
approximately 19 properties at fluvial flood risk within the study area.  

The current standard of protection for the study area is unknown at the time this report is 
written, however investigations are ongoing and should be used in any future studies. 

During the December 2015 flood event, the River Aire overtopped due to high water levels 
caused by prolonged, heavy rainfall. In additional to the high flows two containers were swept 
into the river and became stuck under Baildon Bridge constricting the flow in that section.  

Based on all the available information, EA had estimated that the December flood event has 
1.3% – 1% annual exceedance probability (AEP). It means, that an event has between 1 in 80 
and 1 in 100 chance of occurring in any single year. 

This report will identify potential solutions to the flooding and determine if there is scope to 
determine the best cost/benefit solution to manage this flood risk. 

1.2.2 Objectives 

The primary objective of this initial assessment is to identify the flood risk issues and viable 
solutions for the affected properties and to identify any other potential flood risk management 
measures which are consistent with the current CFMP policy. 

The purpose of this report is to lay the groundwork and, where applicable, provide a business 
case for future more detailed appraisal. The report aims to achieve the following: 

• Confirm the need for a project; 
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• Identify the issues and Political, Environmental, Societal, Technological, Legislative 
and Economic (PESTLE) drivers and opportunities related to the need; 

• Identify the options to address the need and problem; 

• Demonstrate that viable options exist based upon the available information; 

• Provide sufficient information to allow the packaging and optimisation of packages of 
future appraisal, design and construction packages; 

• Provide sufficient information for the appraisal scope to be prepared; 

• Make an assessment on the deliverability of the project; 

• Provide a basis/starting point for discussion with communities and partner 
organisations for use in the development of potential schemes and negotiations 
regarding funding contributions. 

 

1.3 Benefits 

In this area the primary benefit associated with a reduction in flood risk would be the reduction 
in economic damages to properties. This would result in reducing disruption to local transport, 
businesses, private residences and other infrastructure.  

Social benefits relate primarily to a reduction in stress, health effects (including risk to life) and 
loss of memorabilia for those at risk. 

An appraisal period of 100 years is assumed, over which the current Standard of Protection of 
existing assets is expected to decrease as a result of climate change. 

Table 1.1 shows the properties at risk within the study area. 
 
Table 1.1 Number of Properties at Risk (based on current outlines) 

Property Type Flood Risk Number of 
Properties 

≥1 in 20 year (5% AEP) 
(Very Significant Risk) 

0 

<1 in 20 year (5% AEP) 
≥1 in 75 year (1.33% AEP) 
(Significant Risk) 

9 Residential  

<1 in 75 year (1.33% AEP)  
≥1 in 200 year (0.5% AEP) 
(Moderate Risk) 

0 

≥1 in 20 year (5% AEP) 
(Very Significant Risk) 

0 

<1 in 20 year (5% AEP) 
≥1 in 75 year (1.33% AEP) 
(Significant Risk) 

10 Non-Residential 

<1 in 75 year (1.33% AEP) 
≥1 in 200 year (0.5% AEP) 
(Moderate Risk) 

0 

Detail of the methodology used for assessing the benefits of each option is detailed in Appendix 
C. 

 

1.4 Options 
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A long list of options has been compiled. The table on the following page shows the large range 
of long list options considered and the reasoning for or against them being taken forward to the 
short list of options to be assessed.
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Category Long List 
Option 

Water 
Course / 
Areas 
Affected 

Description Take Forward for 
assessment? 

Reasoning / Notes / Past Study 
Reference 

Do nothing Do nothing  All operational and maintenance 
activities cease 

Yes Required to support development of 
business case and benefit cost ratios. 

Do minimum Do Minimum  Continue with current operational 
and maintenance activities.  

Yes Required to support development of 
business case and incremental b/c 
ratio. 

Non-structural 
(by EA) 

Improved flood 
warning 

 Enhanced flood warning to allow 
residents to prepare plus 
appropriate implementation of flood 
action plans 

No A flood warning system is already in 
place for Baildon.  Not funded via the 
capital programme 

Non-structural 
(by EA) 

Flood action 
plans 

 Improved direction of reactionary 
flood defence measure (fire crews, 
temporary pumps, etc.) 

No Recommended as best practice, and a 
plan must be in place to respond to a 
breach in defences. Not taken forward 
for assessment as not part of capital 
programme of works. 

Property level 
protection 

Property level 
protection 

 Protection to individual properties 
(e.g. via air brick covers, door 
guards etc.).  

Yes Passive solutions to be considered as 
an option (flood doors, automatic 
airbricks, pumps, external sealant) 

Operational 
(by Others) 

Improve 
operation/design  

 Remove or lower Baildon weir. Yes Baildon weir is located adjacent of the 
site.  Lowering or removing the weir will 
lower the water levels adjacent to the 
site. 

Planning Land re-
designation 

 Re-designation / reuse of land in 
affected areas - long-term (100yr). 

No Not a solution for the main problem. 
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Category Long List 
Option 

Water 
Course / 
Areas 
Affected 

Description Take Forward for 
assessment? 

Reasoning / Notes / Past Study 
Reference 

Land 
management 

Attenuate flows in 
urban areas 
(SUDS) 

 Use of SUDS drainage on new 
developments, make changes to 
urban areas to reduce speed of 
runoff. 

No Flooding only due to overtopping of 
defences. This would not have an 
impact on risk. 

Urban 
drainage 

Improve urban 
drainage. 

 Improve surface water drainage 
system. 

No Flooding only due to overtopping of 
defences. This would not have an 
impact on risk. 

Structural Linear Defences  Repair and strengthen existing 
flood defences. 

Yes The existing defences along the river 
bank were overtopped.   Repair and 
raise existing flood defences to 
increase standard of protection. 

Structural Linear Defences  Replace the existing defences flood 
along the river front. 

Yes The existing defence may not be able to 
be increased in height, in this situation 
the entire defence will need to be 
replaced.  

Structural Conveyance  Channel deepening or widening Yes Shoal clearance should be made but it 
should be considered as an additional 
option rather that a main option.  

Structural Conveyance  Supplementary bypass channels, 
tunnels or floodway 

No The site in an urban location, there is 
insufficient space for a bypass due to 
consistent development within that area 
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Category Long List 
Option 

Water 
Course / 
Areas 
Affected 

Description Take Forward for 
assessment? 

Reasoning / Notes / Past Study 
Reference 

Flood storage 
area  

Online  Use of active structures and re-
profiling to store water online. (River 

Worth). 

Yes Online flood storage area North of 
Haworth. 
The Upper Aire SFRA identified two 
potential storage areas on the River 
Worth upstream of Keighley. Use of 
these sites would reduce peak flows in 
Keighley increasing the standard of 
protection provided by the Worth 
scheme. 

Flood storage 
area  

Online  Use of active structures and re-
profiling to store water online. 

Yes Leeds FAS Phase 2 modelling study to 
be completed by the end of February 
2018 It will be worth to take them into 
account in the future before any works 
carrying on.  

Flood storage 
area 

Offline  Gravity or pumping to offline 
storage area 

No Not considered as an option.  No 
suitable areas identified. 

Floodplain 
storage 

Washlands-type 
scheme 

 Enhance/increase natural floodplain 
attenuation with cascade of passive 
storage areas in existing floodplain 

Yes Cricket ground and floodplain areas 
upstream of the site could be 
considered as a floodplain storage 
areas. 
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1.4.1 Shortlisted options description 
 

Do Nothing 

The Do Nothing option is defined as taking no action whatsoever; under this option all 
management activities would cease, including maintenance and repair work to existing assets. 

Under this assumption, the natural deterioration of the river channel will occur, leading to an 
increase in flood risk. 

There could be some advantages of this option in the form of habitat creation due to wetting of 
dry areas and naturalisation of channel, however, this is also likely increase the risk to people 
and wildlife. 

The Do Nothing option is not to be taken forward as a viable option as it results in an 
unacceptable increase in flood risk to people and property due to failure and deterioration of 
assets and blockages to the channel, however it is required to be assessed in order to develop 
the business case. 

Do Minimum 

The Do Minimum option is defined as the minimum level of action or intervention necessary to 
maintain defence at their current level presently offered throughout the study area. Under the Do 
Minimum scenario the existing defences are maintain until the end of their design life but are not 
replaced. 

The advantage of Do Minimum is that it sustains current standard of service within the study area 
and minimises initial capital outlay.  

Option 1 – Property Level Protection 

This option considers providing property level protection measures for the properties that were 
affected by the December 2015 flood event. PLP can take the form of barriers in doorways, non-
return valves fitted to drains, and airbrick/vent covers. Properties can also be made more flood 
resilient, using waterproof plaster, solid concrete floors or tiled floor coverings in order to reduce 
the amount of time and money needed to recover from a flood event. PLP is generally used as an 
option for properties that experience less than 500mm of flooding. 

The EA have requested the use of passive measures to maximise the effectiveness of the 
measures, ensuring the measure are installed at times of flooding. 

Property level protection prevents water entering the property but water will still retained by the 
building structure.  Furthermore, PLP does not provide any wider environmental benefits and 
does not prevent the flooding of areas surrounding the property. 

There are currently no properties in the very significant flood risk category, therefore this option 
will not be eligible for FDGiA funding. 

This option is repeated for the other sites in Baildon, however the costings are based on the 
number of properties at risk in each individual benefit area.  Therefore the costs will be different 
for each benefit area.  

 

Option 2 – Removal of Baildon Weir 
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Baildon Weir is located downstream of Baildon Bridge and is owned by a 3rd party.  This option 
involves removing the weir to lower the upstream water level.  It is recommended that further 
detailed hydraulic modelling of this option is undertaken to confirm the changes in water levels as 
the bridge upstream and confluence with the Bradford Beck downstream makes the hydraulics 
complex. 

The EA have already completed modelling for the 3 Weirs Project.  The modelling involved 
running the estimated December 2015 flows with the removal of three weirs in the River Aire; 
Hirst Weir, Saltmill Weir and Baildon Weir. The results show that the removal of Baildon Weir has 
a small impact on water levels around Baildon.  However the modelling completed to date only 
considers one flood event and the removal of the weir could be more beneficial at lower order 
events. 

 

Option 3 – Repair Linear Defence 

The Glenaire Court cell is already protected by flood defences.  The existing flood wall runs along 
the river frontage.  Within the cell a landowner has raised the level of the flood wall.  No 
construction details have been provided for the wall therefore it cannot be determined if the wall 
is suitable for a flood defence.   

This option looks at repairing and maintaining the existing defences throughout the 100 year 
appraisal period.  As it cannot be determined if the 3rd party walls are built to acceptable 
standards they have been excluded from this option. 

This option is repeated for the other sites in Baildon, however the costings are based on the 
length of river frontage along individual benefit areas.  Therefore the costs will be different for 
each benefit area.  

 

Option 4 - Improve Linear Defence 

The Glenaire Court cell is already benefitting from flood defences.  This option proposes 
providing a uniform standard of protection of 1% (1 in 100 year) AEP and maintain the standard 
over the 100 year appraisal period. This option includes extending the existing flood wall and 
tying into high ground to prevent the defences being outflanked. 

As mentioned in option 3, a 3rd party has already raised the flood wall.  As the construction detail 
of the wall is unknown it has been assumed that a new wall will be required.   

Raised defences at Baildon were proposed as part of the long-term plan for the Upper Aire Flood 
Risk Management Strategy (2009). 

Limited water level data  is available for this assessment, therefore a nominal defence height of 
1m was assumed for this option. Further analysis will be required to refine the defence height if 
the option is carried forward. 

This option is repeated for the other sites in Baildon, however the costings are based on the 
length of river frontage along individual benefit areas.  Therefore the costs will be different for 
each benefit area.  

 

Option 5 – Flood storage areas (River Worth) 

The 2014 Upper Aire SFRA identified a site near Lord Lane north of Haworth that could 
potentially be used as a flood storage area. This option provides a reduction in flood risk from the 
River Aire further downstream. The SFRA estimated the use of this area could potentially result in 
a 7% reduction in peak Aire flow and a 50mm reduction in flood depths in Leeds. 
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The impact of the storage area on Baildon will be to reduce flood risk however the magnitude of 
the impact is uncertain.  This option can be used in conjunction with other options, for example 
reducing the flood defences.   

The scheme will also provide a reduction in flood risk beyond the study area. As a result the 
benefit-cost ratio for the option will be artificially low, being limited to the Baildon benefits.  
Therefore the economic analysis for the option is not presented in this report but the option 
should be considered in any future studies. 

Option 6 – Flood storage areas (River Aire) 

The Leeds FAS Phase 2 scheme has identified three locations that could be potentially used as 
flood storage areas; Keighley Holden Park, Marley Bridge and Rodley.  The Rodley site is 
downstream of our study area but the other two sites could potentially provide benefits for 
Baildon.  The Upper Aire FRMS has estimated a reduction of 300mm to 400mm for a 1% (1 in 
100 year) AEP event at Leeds Station.  The impact at Baildon, however, is uncertain but is 
expected to be significant on peak water levels. 

The scheme will also provide a reduction in flood risk beyond the study.  As a result the benefit-
cost ratio for the option will be artificially low, being limited to the Baildon benefits.  Therefore the 
economic analysis for the option is not presented in this report but the option should be 
considered in any future studies. 

 

Option 7 – Floodplain storage 

This option considers maximising the potential floodplain storage.  There is currently one 
designated washland site identified by the EA; the sports ground and adjacent area on the left 
bank of the River Aire, opposite Masons Mill, upstream of Baildon Bridge 

The proposal is to lower the existing ground level of these washland areas to allow the areas to 
fill earlier and store a larger quantity of floodwater, reducing the river water levels. The option is to 
reduce the existing levels of the site by 1m and create circa 38,200m3 of additional storage. 

This option requires testing in the hydraulic model to confirm its viability and effectiveness. The 
option is technically feasible however there are risks associated with gaining land owner consent. 
The standard of protection provided by this scheme is highly uncertain until further modelling is 
carried out.  

This option is repeated for the other sites in Baildon, the costing for the option will be the same 
for all the benefit areas. 

Additional works 

Raising Baildon Bridge has been proposed as an option for the other sites in Baildon/Shipley in 
proximity of Glenaire Court site. This option proposes to raise the height of the bridge deck by 1m 
to increase the conveyance under the bridge and reduce the chance of blockages.  

This option requires hydraulic modelling to confirm its viability and effectiveness, passing more 
water beneath the bridge is likely to reduce upstream flood risk but could also increase flood risk 
downstream, within the Glenaire Court site. 
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1.4.2 Costs of options 

Confirm that the options costs (initial implementation and whole life) are within the estimates 
identified in the approved Strategy or agreed System Asset Management Plan, briefly explaining 
the implications, if any, of any variance 

The costs for the options were calculated using the Environment Agency’s Project Cost Tool and 
Long Term Costing Workbook. The maintenance and operation costs relate to mechanical 
maintenance of the assets to Target Condition 3. 

It is assumed that a major replacement of assets will be required at some point during the 
appraisal period after the initial construction phase. The timing of these replacements is based on 
the EA’s Asset Deterioration Guidance (2013), and the assumptions are outlined in Appendix B.  

An appraisal period of 100 years has been used. A detailed breakdown of costs across this 
period is included in Appendix B. 

Table 1.2 shows the build-up of costs for all options. 

Table 1.2 Project costs (£k) 

Item Do 
Minimum  

Option 
1 

Option 
2 

Option 
3 

Option  
4 

Option 
7 

Construction 
Costs 

 
125 2,456 136 1,015 1,551 

Environment 
Agency staff 

 
20 182 21 75 115 

Consultant fees 
(appraisal) 

 
8 128 9 53 81 

Consultant fees 
(design) 

 
27 349 29 144 220 

Consultant fees 
(construction) 

 
7 145 8 60 92 

Site investigation 
& survey 

 
2 98 2 41 63 

Land purchase  0.1 12 0.1 5 8 
Optimism Bias 
(44%) 

 
83 1,482 90 613 937 

TOTAL  272 4,851 295 2,005 3,065 
Annual Operation 
and Maintenance 
Costs (including 
optimism bias) 

 0.4 0.4 0.4 0.4 0.4 

 

1.5 Initial environmental assessment 

The main impacts of each option are summarised in Table 1.3: 
 
Table 1.3 Key environmental impacts, mitigation and opportunities 

Key positive impacts Key negative impacts Mitigation/ enhancement 
opportunity 

Option 1 
Reduced risk of flooding. Option only protects properties 

and not surrounding land. 
 

 

Option 2  
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Key positive impacts Key negative impacts Mitigation/ enhancement 
opportunity 

Reduced risk of flooding. 
 
Reduces future maintenance 
costs for properties at risk 

Construction work takes place in 
a watercourse. Risk of pollution 
incidents and disruption to area 
during construction. 
 
Construction work takes place in 
a watercourse. Risk of health 
hazards - possibility of 
contaminated water and water 
borne diseases. 

Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance. 
 
 
 
The designer should give 
consideration to any options which 
may reduce the effect of the 
identified hazards. 

Option 3  
Reduced risk of flooding. 
 
Reduces future maintenance 
costs for properties at risk 

Construction work takes place 
alongside watercourse. Risk of 
pollution incidents and disruption 
to area during construction. 

Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance. 

Option 4  
Reduced risk of flooding. 
 
Reduces future maintenance 
costs for properties at risk 

Construction work takes place 
alongside watercourse. Risk of 
pollution incidents and disruption 
to area during construction. 
 
Visual impact of raising wall 

Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance. 

Option 5  
Reduced risk of flooding. Construction work takes place 

alongside watercourse. Risk of 
pollution incidents and disruption 
to area during construction. 

Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance. 

Option 6  
Reduced risk of flooding. Construction work takes place 

alongside watercourse. Risk of 
pollution incidents and disruption 
to area during construction. 

Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance. 

Option 7  
Reduced risk of flooding. Construction work takes place 

alongside watercourse. Risk of 
pollution incidents and disruption 
to area during construction. 

Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance. 

 
 
 
 
 
 

1.6 Consultation 

The options in this appraisal were developed in consultation with the Environment Agency and 
Bradford MDC. No public consultations were held at this stage as the work is a high-level 
assessment of potential options. Stakeholder engagement will take place at subsequent stages of 
the project. 

If this project is taken forward for further appraisal it is recommended that consultation is focused 
on, but not limited to, the following: 

• Residents in the area at risk 

• Landowners and developers for the upstream storage option. 

• Riparian landowners, especially owners of riverside walls acting as informal defences 
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1.7 Economic summary and preliminary preferred opti on 

Table 1.4 summarises the economic assessment carried out for all options. The calculations for 
PV benefits area shown in Appendix D. The options are ordered by benefit (lowest benefit first). 

This benefit values are estimates based on the methodology detailed in Appendix C. There is 
significant uncertainty in these estimates, which are based on Weighted Annual Average Data 
(WAAD) from the Multi-Coloured Manual (MCM, 2015/16). If this project progresses to further 
appraisal the benefits of these options should be more accurately assessed though hydraulic 
modelling and use of the more detailed flood depth / damage data from MCM.  

 
Table 1.4 Benefit-cost assessment  

 PV 
costs 
(£k) 

PV benefits  
(£k) 

Av. 
BCR 

Incr’ 
BCR 

Option for iBCR 
calc  

Comments 

Do Nothing        

Do 
Minimum 

11 
Low       106 
Mid        142 
High      177 

9.5 
12.6 
15.8 

 
 

Highest ABCR 

Option 3 717 
Low    986 
Mid     1,314 
High   1,643 

1.4 
1.8 
2.3 

1.3 
1.7 
2.1 

Do Minimum 
Positive ABCR 

Option 1 563 
Low    2,005 
Mid     2,674 
High   3,342 

3.6 
4.7 
5.9 

3.4 
4.6 
5.7 

Do Minimum 
Positive ABCR 

Option 7 3,076 
Low    2,408 
Mid     3,211 
High   4,014 

0.8 
1.0 
1.3 

0.2 
0.2 
0.3 

Option 1 
Positive ABCR 

Option 2 4,863 
Low    2,317 
Mid     3,090 
High   3,862 

0.5 
0.6 
0.8 

0.1 
0.1 
0.1 

Option 1 
 

Option 4 1,999 
Low    2,658 
Mid     3,544 
High   4,430 

1.4 
1.8 
2.3 

0.5 
0.6 
0.8 

Option 1 
Positive ABCR 

 

The Do Minimum scenario has the highest ABCR justifying the continuation of the current 
maintenance regime. 

Option 1, Property Level Protection, is the Do Something option with the highest ABCR.  There is 
uncertainty over the effectiveness of a PLP scheme, further investigation into suitability of the 
properties to be fitted with property protection measures.  The option can be carried forward to 
the next stage however it is not eligible for FDGiA funding.    The Flood and Coastal Resilience 
Partnership Funding (EA) document states that property level protection can be funded under 
OM2 for residential properties only if they are within the very significant risk category.  There are 
no residential properties in the very significant category in the benefit area therefore the option 
will need to be wholly funded by another funding stream e.g. local levy funding. 

Option 4, improve existing defences, also has an ABCR above parity but lower than Option1.  
However, Option 4 offers community wide protection compared to Option1, which only protects 
the properties and should be taken forward. 

 
1.7.1 Funding and contributions 

Preliminary estimates for Partnership Funding scores for Option 4 has been calculated as shown 
in Table 1.5.  Due to the FDGiA funding rules option 1 is not eligible for GiA funding so no funding 
calculation has been undertaken. 
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Table 1.5 FDGiA Funding Calculator 
 

 

. Other potential funding sources identified include: 

• Community Infrastructure Levy 

• Benefitting local businesses 

• Council Tax 

• Local Enterprise Partnerships 

1.7.2 Key delivery risks (economic, social and envi ronmental) 
Key delivery risk and recommendations for mitigating these risks are shown in the table below. 
 
Table 1.6 Risks and mitigation  
Risk Key Mitigation 

Insufficient 3rd party Funding available to allow 
scheme to progress. 

Assess potential funding options before 
progressing scheme appraisal further. 

Risk of reducing the aesthetics of buildings (PLP) 
When considering resistance measures keep 
in mind their impact on aesthetics of buildings 
(PLP) 

Risks associated with gaining land owner consent. 
Early consultation with landowners should be 
undertaken. 

Inaccurate benefits assessment due to limited 
understanding of flood risk hence unreliable 
approach to economic damage calculations used for 
IA’s. 

A more accurate damages assessment based 
on hydraulic modelling and flood depth 
damage data should be considered before 
progressing to further appraisal. 

 

1.8 Project Scoring 

Contributions to outcome measures  Option 4 

OM1 – Economic Benefit:   

    Benefit period used for Partnership 
Funding calcs 100 

    PV Benefits (£k) 3,544,397 

    PV Costs (£k) 1,998,991 

    Benefit/Cost ratio 1.8 

OM2 – No. of households moved out of any 
flood probability category to a lower category 

9 

OM2b – No. of households for which the 
probability of flooding or coastal erosion is 
reduced from the very significant or 
significant category to the moderate or low 
category 

0 

OM2c – No. of households in the 20% most 
deprived areas moved from the very 
significant or significant flood probability 
category to the moderate or low category  

0 

Partnership Funding (PF) Score  11% 

Contributions required for a PF score of 
100% 

£1,772,515 

Contributions required for a PF score of 
120% 

£1,810,244 
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The data used in this assessment has been subjected to a RAG assessment. RAG status 
reporting is used to indicate the level of confidence in the data used in each aspect of the 
assessment, using the traffic light system. This gives a three figure score with the first number 
being the number of reds (showed as a letter R)), where there is significant uncertainty or 
challenges. The second and third numbers are the numbers of amber (A) and greens (G). The 
results are shown below: 

• A – Problem Definition:  The fluvial flooding mechanism are well understood but the 
other sources of flooding are currently unknown – AMBER  

• B – Economic Case: The benefits assessment has been based on moving properties 
from flood risk bands and weighted average annual damages – RED 

• C – Funding:  The options are likely to require external funding.  Alternative funding 
sources have been identified – AMBER  

• D – Engineering case:  Solutions taken to outline design and are tried and tested 
defence options, however may need significant change due to other flooding sources 
– RED 

• E – Permissions & Consents:  Solution are unlikely to require unusual permissions or 
consents – GREEN 

• F – Environmental sensitivities: Initial environmental assessments has been 
completed based on outline options – AMBER  

• G – Opportunities: Some potential opportunities for partnership working but minimal 
environment opportunities – AMBER  

Model. 

A 

Econ. 

B 

Funding 

C 

Eng. 

D 

Permission  

E 

Env. 

F 

RAG Opps. 

G 
2 3 2 3 1 2 231 2 

 

1.9 Further work requirements 

If the project is taken forward for further appraisal it is recommended that the following work is 
carried out: 

• Investigate the impacts of upstream storage options proposed by the Leeds Phase 2 
PAR and Upper Aire SFRA.  The findings should be used to review and update the 
economic assessment.  

• Option 2 – Further investigation and hydraulic modelling of the removal of Baildon 
weir, including lower order return periods.  The impacts of the scheme should also be 
investigated outside of the Aire Close benefit area to identify additional benefits. 

• Option 7 – upstream storage will have benefits outside of the study area.  Hydraulic 
modelling of this option should be carried out to assess if the changes in downstream 
water level potentially provide additional benefits. 
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1.10 Conclusions and Recommendation 

The conclusions and recommendations made in this section are based on the limited data 
available at the time.  It is strongly recommended that further investigation into all sources of 
flooding is undertaken.  

Based on the evidence provided, it isunderstood the main risk of flooding within Shipley/Baildon 
is fluvial from the overtopping of river banks. The existing fluvial flood risk is moderate to high.  
There was significant flooding in the area during Boxing Day 2015 from the River Aire.  

 

Option 1, property level protection is the highest scoring Do Something option, however due the 
funding rules is unable to gain any FDGiA funding.  There is uncertainty over the effectiveness of 
a PLP scheme, further investigation into suitability of the properties to be fitted with property 
protection measures. 

Option 4, improve existing defences is the next highest scoring option, and offers community 
wide protection, unlike Option 1 and therefore should be the preferred option.  If the option is 
classified as Capital Maintenance it would be eligible for 11% of the costs being funded by FDGiA 
funding. 

It is recommended that the flood storage options are considered further in a wider strategic 
assessment as they could benefit a large area on the Upper Aire. 

The Baildon/Shipley area is comprised of five individual benefit areas; Aire Close, Baildon Bridge, 
Glenaire Court, Lower Holme and Masons Mill.   It is recognised that there is potential to manage 
flows upstream and provide further benefits to all areas.  Potential storage sites have been 
identified between Hirst Mill and Baildon Bridge, see figure 2 in Appendix H.  It is recommended 
that further hydraulic modelling be undertaken to investigate the impact of these storage areas on 
water levels within the Baildon/Shipley area and further downstream.   

Based on the limited information we have available, we recommend option, Do Minimum 
scenario, to be the most appropriate. However, we recommend further investigations are 
undertaken to determine all flood risk sources, and how they can be managed.  
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Appendices 


